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[bookmark: _Toc168371362][bookmark: _Toc178582896][bookmark: _Toc256683200][bookmark: _Toc111618208]Mis on MS EXCEL ? 

[bookmark: _Toc168371365][bookmark: _Toc178582897][bookmark: _Toc111618210][bookmark: _Toc153614692]Microsoft Excel on samuti Microsoft Office-i üks osa nagu MS Word'gi. Programm on mõeldud arvutuste teostamiseks tabelites. MS Ecxeli abil on võimalik vormistada kõiksuguseid tabeleid ja töödelda andmeid nendes,  lisada tabelitele illustreerivaid diagramme, analüüsida andmebaase, samuti lahendada arvutamis- ja planeerimisülesandeid.

[bookmark: _Toc256683201]MS Excel ekraanipilt ja menüüd

Tabelitöötlusprogrammi MS Excel 2007 käivitamiseks: Start -> Programs -> Microsoft Office -> Microsoft Office Excel 2007. Peale käivitumist avaneb MS Excel aken ja nähtav pilt peaks vastama enam-vähem joonisel kujutatule. 
[bookmark: _Toc149381114][bookmark: _Toc153614693][bookmark: _Toc156639614][bookmark: _Toc156639949][bookmark: _Toc168371367][bookmark: _Toc178582898]
Exceli vana kujundusega menüüde ja nuppude asemel on nüüd uus lint ( ing. Ribbon) vahekaartidega, mida tuleb käskudeni jõudmiseks klõpsata. Lint loodi selleks, et Exceliga oleks parem töötada ning et vajalikke käske oleks lihtne leida ja kasutada.
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)[image: Lint kuvatakse horisontaalselt Exceli akna ülaosas ]

Exceli põhilised mõisted

· Tööleht (Sheet) - joonitud ekraaniosa, mis on jagatud veergudeks ja ridadeks ning kuhu kasutaja koostab oma tabeli
· Rida (row) - tähiseks on number 1, 2, ..., 30, ... 
· Veerg (column) - tähiseks on täht A, B, ..., Z, AA, AB, ... 
· Lahter ehk pesa (cell) - rea ja veeru ristumiskoht. Igal lahtril on aadress, mille moodustavad veerutäht ja reanumber (A1, C5 jne.). 
· Plokk - lahtritest ristkülik, tähistatakse vasaku ülemise ja parema alumise lahtri tähisega, eraldajaks on koolon (näiteks A1:H1, C2:K12 jne.). 
[bookmark: _Toc256683202]
Exceli tööriistad: vahekaardid, rühmad ja käsud
[bookmark: _Toc149381115][bookmark: _Toc153614694][image: Vahekaart Kodu, rühm Joondus ja käsk Murra teksti ridu]
Lint koosneb kolmest osast: vahekaardid, rühmad ja käsud.
1. [bookmark: _Toc207787358][bookmark: _Toc219186770][bookmark: _Toc256682984][bookmark: _Toc256683203]Vahekaardid. Neid on kokku seitse. Igaüks neist tähistab Excelis tehtavaid põhitoiminguid.
2. [bookmark: _Toc207787359][bookmark: _Toc219186771][bookmark: _Toc256682985][bookmark: _Toc256683204]Rühmad. Iga vahekaart sisaldab seotud üksuste rühmi.
3. [bookmark: _Toc207787360][bookmark: _Toc219186772][bookmark: _Toc256682986][bookmark: _Toc256683205]Käsud. Käsuks võib olla nupp, boks, kuhu saab teavet sisestada, või menüü.
Exceli põhikäsud on koondatud esimesele vahekaardile, milleks on Home (Kodu).  Sellel vahekaardil olevaid käske kasutatakse töölehel kõige sagedamini.
[bookmark: _Toc207787361][bookmark: _Toc219186773]Rühmad koondavad kokku kõik käsud, mida teil võib mõne kindla toimingu juures vaja minna, kusjuures need jäävad kuvatuks ja kergesti kättesaadavaks kogu toimingu ajal, mitte ei ole menüüde varjus. 
Näiteks käsud Copy, Cut, Paste on paigutatud esimesena vahekaardi Home rühma Clipboard (Lõikelaud).  Järgmisena on toodud fondi vormindamise käsud rühmas Font. Teksti keskele, vasakule ja paremale joondamise käsud asuvad rühmas Alignment (Joondus). Lahtrite, ridade, veergude ja töölehtede lisamise ja kustutamise käsud rühmas Cells (Lahtrid) jne.

[bookmark: _Toc207787362][bookmark: _Toc219186774][bookmark: _Toc256683206]Lindi minimeerimine
Lindi eesmärk on aidata teil mõne kindla toimingu sooritamiseks vajalikud käsud kiiresti üles leida. Linti ei saa kustutada ega Microsoft Office'i varasematest versioonidest tuttavate tööriistaribade ja menüüdega asendada. Küll aga saate lindi minimeerida, et ekraanil oleks töö jaoks rohkem ruumi.  Kui soovite linti kiiresti minimeerida, topeltklõpsake aktiivse menüü nime. Lindi taastamiseks topeltklõpsake uuesti mõnda menüüd.

[bookmark: _Toc207787363][bookmark: _Toc256683207]Dialoogiaknad
[image: Dialoogiboksi alumises nurgas olev märk, mis tähistab enamaid suvandeid, ja dialoogiboks]
Kui te näete rühma alumises paremas nurgas seda noolt [image: Nupu pilt]  (seda nimetatakse dialoogiakna käivitiks), on selle rühma puhul saadaval rohkem suvandeid. Klõpsake noolt, mispeale kuvatakse dialoogiboks või tööpaan.
[bookmark: _Toc207787364][bookmark: _Toc219186776]Näiteks vahekaardi Home rühmas Font on olemas kõik käsud, mida fondi muutmisel kõige sagedamini kasutatakse, sealhulgas käsud fondi suuruse muutmiseks või paksu, kursiivis või allakriipsutatud fondi kasutamiseks.
[bookmark: _Toc207787365][bookmark: _Toc219186777]Kui teil läheb vaja rohkem suvandeid, näiteks ülaindeksit, klõpsake noolt [image: Nupu pilt], mis asub paremal pool käsku Font. Seejärel kuvatakse dialoogiaken Format Cells, mis sisaldab nii ülaindeksit kui ka teisi fondiga seotud suvandeid
[bookmark: _Toc148712768][bookmark: _Toc153614698][bookmark: _Toc111618209][bookmark: _Toc153614702][bookmark: _Toc256683208][image: ]
 
Kiirpääsuriba

Kui te kasutate sageli käske, mis ei ole teie meelest piisavalt kiiresti kättesaadavad, võite need hõlpsasti lisada kiirpääsuribale, mis asub Excel 2007 esmakordsel käivitamisel lindi kohal. Sellel tööriistaribal on käsud alati nähtavad ja käepärast.


[image: ]

Näiteks kui te kasutate iga päev automaatfiltrit ja ei taha iga kord klõpsata vahekaarti  Data, et pääseda käsuni Filter, võite käsu Filter lisada kiirpääsuribale.

Selleks paremklõpsake käsku Filter ja seejärel klõpsake käsku Add to Quick Access...

[image: ]

Valmis!

[image: ]

Kui soovite sellelt tööriistaribalt mõne nupu eemaldada, paremklõpsake nuppu ja siis klõpsake käsku Remove from Quick Access


[bookmark: _Toc256683209][image: Nupu pilt]
Uus Microsoft Office'i nupp 

Microsoft Office'i nupp  kuvatakse akna ülemises vasakus nurgas mitmes Microsoft Office'i programmis. See sisaldab samu põhikäske, mis enne asusid menüüs File ja mille abil saab dokumente avada, salvestada ja printida.

[image: ]

Lisaks võimaldab Microsoft Office'i nupp teile juurdepääsu programmisätetele, mille abil saab näiteks määrata õigekirja kontrollimise eelistused. Klõpsake menüü allosas olevat käsku Excel Options  (Excel suvandid) ning klõpsake seejärel mis tahes kategooriat vasakul olevas loendis.



[bookmark: _Toc168371371][bookmark: _Toc178582902]
[bookmark: _Toc256683210]Exceli faili ülesehitus
Exceli töökeskkond annab meile aluse arvude ja teksti paigutamiseks, et siis nende andmete põhjal arvutusi teostada, analüüsida, diagramme koostada, andmebaase üles ehitada.
Exceli faile nimetatakse töövihikuteks (ing. Book). Ühes töövihikus võib olla mitu töölehte (ing. Sheet). Töölehtede arv on piiratud vaid arvuti mälumahuga, sellest siis ka nimetus töövihik. 
Töölehel suurte andmehulkade uurimise võimaldamiseks toetab Office Excel 2007 töölehel kuni ühte miljonit rida ja 16 tuhandet veergu. Täpsemalt moodustab Office Excel 2007 ruudustiku 1 048 576 rida ja 16 384 veergu, mis teeb 1500% rohkem ridu ja 6300% rohkem veerge, kui oli versioonil Microsoft Office Excel 2003. 
Read on vasakul nummerdatud, veerge tähistatakse tähtedega.
Rea ja veeru ristumiskoht on lahter ehk pesa (ing. cell). Igal lahtril on aadress, mis koosneb veeru tähest ja rea numbrist. Näiteks, ülemine vasakpoolne on A1.  MS Exceli päises paikneb aktiivse lahtri aadressi näitav aadressikast.
 (
valemirida
) (
aadressikast
)[image: ]

· Exceli lahtris võib olla arv, tekst, valem või kommentaar. 
· Tekst joondatakse lahtris vasakule, arvud paremale!
· Trükkimise ajal on tekst või arvud näha nii  lahtril kui valemireal.
· Valemite puhul kehtib põhimõte: valemi kirjutame sinna, kuhu tahame vastust. Lahtrisse kirjutame valemi, nähtavale tuleb arvutustulemus.
[bookmark: _Toc479611294][bookmark: _Toc479612043][bookmark: _Toc480082103][bookmark: _Toc178582904]

[bookmark: _Toc256683211]
Exceli töövihik ja põhitegevused töölehtedega

Exceli faile nimetatakse töövihikuteks (Book). Exceli töövihikus peab olema vähemalt üks tööleht (Sheet). Töölehtede arv vihikus ei ole üldiselt piiratud. Neid saab lisada, eemaldada, kopeerida ja teisaldada. 

Lehtedel, mis kuuluvad ühte töövihikusse, peavad olema erinevad nimed. Vaikimisi määrab Excel töölehtede nimed kujul Sheet1, Sheet2, Sheet3... 

[image: ]


Töölehe nime muutmiseks teha topeltklõps lehe nimelipikul, seejärel asenda lipikul nimi ja kinnitada see ENTER-klahvi vajutusega.

Töölehe lisamiseks teha klõps nupul „Insert worksheet“ 
[image: ]
[bookmark: _Toc111618214][bookmark: _Toc113082868][bookmark: _Toc153614705][bookmark: _Toc168371374]
Töölehe kustutamiseks  parem hiireklõps lehe lipikul ja avanenud hüpikmenüüst korraldus Delete: 
[image: ]

Töölehe teisaldamiseks klõpsake lehe lipikul ja lohistage leht soovitus asukohta. Lohistamisel muutub hiirekursor väikeseks leheks ning lehe uut paigutuskohta näitab must kolmnurgake.

Töölehe kopeerimiseks tehke töölehe lipikul paremklõps ja valige <Move or Copy>, avaneb dialoogiaken

 (
Töövihiku valik
) (
tööleht
leht, mille ette paigutatakse lehe koopia
) [image: ]

Ilmuvas dialoogiaknas klõpsata „linnuke“ märkeruutu Create a copy ning valida töövihik ja leht, mille ette paigutatakse lehe koopia. Lehte saab kopeerida ka teise avatud töövihikusse. 
[bookmark: _Toc178582905]
[bookmark: _Toc256683212]Andmete sisestamine ja muutmine

Arvu või teksti sisestamiseks tuleb märkida vajalik lahter ja trükkida sinna, mida vaja.  Tavaline tekst joondub lahtris vasakule ja arvud paremale.

Sisestuse lõpetab Enter klahvi vajutus või hiirega vajutus nupule [image: ] valemireal. Kui sa sisestamise ajal ümber mõtled ja tahad sisestamist katkestada, siis vajuta Esc klahvi või valemireal [image: ] nuppu. Trükkimise ajal on tekst või arvud näha nii  lahtril kui valemireal.

Andmete sisestamisel samal real järgmisse lahtrisse liikumiseks kasuta Tab klahvi. Järgmisele reale saab sisestada peale Enter klahvi vajutust.

Andmeid muuta või vigu parandada saab otse lahtris. Selleks tuleb lahtris teha topeltklõps ja siis muudatus. Sümbolite kustutamiseks on järgmised klahvid:

·   Delete - kustutada üks sümbol kursorist paremalt.
 Backspace - kustutada üks sümbol kursorist vasakult
Viimasena täidetud käsu tühistamiseks saab kasutada [image: ] (Undo)  nuppu. 
Tühistamise tühistamiseks kasutatakse [image: ] (Redo) nuppu. 
Kui lahtrisse tekib märk ### tähendab see,et kirje ei mahu lahtrisse ära. Siis peab laiendama veergu. 

[bookmark: _Toc256683213][bookmark: _Toc153614706][bookmark: _Toc168371375][bookmark: _Toc178582906]Veeru laiuse ja rea kõrguse muutmine

Veeru laiust ja lahtri kõrgust saab muuta, kui minna hiirega veerunimesid/reanumbreid eraldava joone peale, nii et hiire kursor muutub noolekujuliseks: 
[image: ]
Vasak hiirenupp alla ja lohistada soovitud laius/kõrgus. Kui lahter on andmetega täidetud, siis topeltklõps samas kohas teeb veeru sama laiaks kui on andmed seal veerus (optimeerimine).
[bookmark: _Toc178582907]
NB! Kui andmete sisestamisel tekib lahtrisse jada trellimärke (########), tähendab see lihtsalt seda, et lahter on liiga kitsas andmetekuvamiseks. Tuleb veerg laiemaks venitada!

[bookmark: _Toc256683214]Andmete kustutamine
Et kustutada lahtri sisu, märgistage lahter (või vahemik) ja vajutage klaviatuurilt Delete.
Et kontrollida täpsemalt seda, mida te kustutate, valige käsk  Clear.  See viib rippmenüüni, mis sisaldab nelja võimalust:
[image: ]
Rippmenüüst valige, mida puhastada:
[bookmark: _Toc153614708][bookmark: _Toc168371377][image: ]


[bookmark: _Toc111618215][bookmark: _Toc113082870][bookmark: _Toc153614709][bookmark: _Toc168371378][bookmark: _Toc178582909][bookmark: _Toc256683215][bookmark: _Toc113082869]Andmete märgistamine ehk plokkimine

Kui on vaja muudatusi teha mingile lahtrite grupile, tuleb nad korraga märgistada ehk plokkida. Selleks märkige üks lahter, hoides hiire vasakut klahvi all lohistage üle järgnevate lahtrite. Plokitud lahtrid jäävad mustaks v. a. esimene. Märgistamist on vaja lahtrite vormingu muutmiseks või andmete kopeerimiseks. 

Selekteerimisoperatsioonid on järgmised:
· Üks lahter - klõps seal. 
· Üks rida - klõps reanumbril. 
· Üks veerg - klõps veerutähel. 
· Lahtrite grupp - vedada hiirega üle lahtrite. 
· Mitu rida - vedada hiirega üle reanumbrite. 
· Mitu veergu - vedada hiirega üle veerutähtede
· Tabel – klahvikombinatsioon Ctrl+A
· Kogu tööleht- klõpsutada tabeli ülemises vasakus nurgas 
[image: Nupp Vali kõik]

Märgistamine klaviatuuri abil - hoida all klahvi Shift ja liikuda nooleklahvidega.  Eraldi asetsevate lahtrite märgistamiseks hoia all Crtl klahvi ja kliki vajalikel lahtritel. Märgistuse tühistamiseks teha tabelis klõps suvalises kohas!
[image: Mittejarjestikused-cellid]
[bookmark: _Toc178582910]


[bookmark: _Toc256683216]Enamkasutatavad hiirekursori tähendused


Programmi Excel kasutades ja erinevaid tööoperatsioone tehes muutub hiirekursor pidevalt. Oluline on jälgida hiirekursori kuju, et mitte anda valesid korraldusi. Järgnevalt on välja toodud enamkasutatavad hiirekursori tähendused:

[image: ]

[bookmark: _Toc178582911][bookmark: _Toc256683217]
Lahtrite sisu kujundamine

MS Excel programmis on päris mitu võimalust sisu paigutamiseks (rühm Alignment)

[image: ]


[bookmark: _Toc256683218]Teksti joondamine 
Põhiline, mida kasutad, on muidugi klõpsamine joonduse nuppudel [image: exceliyl333]
Nende abil saad joondada lahtri sisu vasakule, keskele ja paremale:
[image: exceliyl334]
NB! Vaikimisi tekstid salvestatakse vasakule, arvud ja kuupäevad – paremale!
Vertical  joondusi läheb vaja aga juhul, kui oled teinud ridu kõrgemaks.  Vaikimisi kõik andmed salvestatakse alla.
	 (
-üleval
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-all
)Auto

	Rong
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[bookmark: _Toc256683219]Teksti pööramine 
[image: ]
Teksti suuna muutmist vajad eelkõige veergude pealkirjade puhul. Võivad need ju võtta vasakult paremale kirjutades üsna palju ruumi. Nii, nurgaga või päris alt-üles või ülevalt alla kirjutades, vajad ruumi isegi kordades vähem. 
Teksti viimine mitmele reale [image: Nupu pilt]
Kui te soovite, et tekst oleks lahtris kuvatud mitmel real, piisab, kui klõpsate nuppu Wrap text  (Murra teksti ridu) [image: Nupu pilt] vahekaardi Home rühmas Alignment. 

[bookmark: _Toc153614712][bookmark: _Toc168371381][bookmark: _Toc178582914]Sel juhul muutub lahter kõrgemaks. Kui tahad kirjutamise ajal lahtri piires rida vahetada, siis vajuta Alt + Enter


[bookmark: _Toc256683220]Lahtrite ühendamine
Seda toimingut tuleb üsna sageli teha. Ikka on ju nii, et soovid näiteks panna tabelile ühe suure pealkirja. Ühendamisel pead:
1. Märkima ühendamist vajavad lahtrid.
2. Klõpsama ühendamise ja tsentreerimise nupule (Merge & Center). 
[image: ]
Seega teise sammu tulemusena ühendataksegi lahtrid ja ühtlasi paigutub esimeses lahtris olev sisu ühendatud lahtrite keskele. 
Lahtri sisu kujundamine hõlmab ka:
· Kirja tüübi (Font) määramine
· Kirja suuruse (Font size) määramine
· Kirja laadi (Font style) määramine
· Kirja värvi (Font color) määramine
[image: ]



[bookmark: _Toc219186792][bookmark: _Toc256683221]Rahavorming 

Rahavorminguks on nupp     Selle abil lisab programm raha ühikud ja jätab numbrile kaks kohta peale koma ehk sendise täpsusega. 
[image: image031]


[bookmark: _Toc219186793][bookmark: _Toc256683222]Protsendivorming  

Nupu vajutamisel hakkab programm korrutama kõiki arve 100-ga. Seda muidugi juhul, kui teed lahtrisse sisestatud numbri ümber protsendivormingusse. Eelkõige annab seadistus efekti numbritele, mis on ühest väiksemad. 
Läheb seda sajaga korrutamist vaja olukorras, kus oled tabelisse kirjutanud protsendi tavalise numbrina. Näiteks 1% asemele 0,01 ja 50% asemel 0,5. Kui need numbrid nüüd protsendivormingusse teha, siis lähebki ju vaja 100 korrutamist. Numbritele üle ühe võib sajaga korrutamine juba eksitavalt mõjuda! 
Väikestele numbritele rakendatakse ümardamist!
[image: image038]


[bookmark: _Toc256683223]Komakohtade arvu määramine  


 Lisab ühe koha peale koma (Increase Decimal)
3



 Võtab peale koma ühe koha ära (Decrease Decimal)
	[image: image041] [image: image042] [image: image043] [image: image044] [image: image045]

Kümnendkohtade  nuppudega saad seadistada, mitu kohta on numbreid peale koma. Miinimum on null, max. otsustad ise. Vaevalt, et üle kolme koha sageli võiks vaja minna. Pane tähele, kui komakohti on vähem numbri tegelikust pikkusest, siis hakkab programm ümardama (lõpp 5, 6, 7, 8, 9 annab nö. +1 ehk 3,487 annab 3,49). Arvutusi tehtaks aga ikka lahtris tegelikult asuva numbriga (seega mitte ekraanil kuvatava vorminguga). 


[bookmark: _Toc219186795][bookmark: _Toc256683224]Komavormingu nupuga     
saad numbreid joondada komakoha järgi:
[bookmark: _Toc178582912][image: image033]
[bookmark: _Toc256683225]
Automaatsumma
[bookmark: _Toc153614710][bookmark: _Toc168371379]
Automaatsumma [image: Käsk Automaatsumma] - kõigi ühes veerus (või reas) olevate väärtuste liitmine
Kasutage seda funktsiooni aja kokkuhoiu mõttes iga kord, kui soovite mingeid väärtusi liita.
[image: Nupu Automaatsumma kasutamine]
[image: 1]Valige lahter kuhu tahate vastust saada (nt. B7) ja klõpsake nuppu AutoSum [image: Käsk Automaatsumma]
[image: 2]Valemi lahtreid ümbritseb värviline valikuraam 
[image: 3] Vajutage sisestusklahvi (ENTER), mispeale tulem kuvatakse lahtris B7.



[bookmark: _Toc153614711][bookmark: _Toc168371380][bookmark: _Toc178582913]


[bookmark: _Toc256683226]Ridade  või  veergude  lisamine  ja  kustutamine

Võib juhtuda, et pärast andmete sisestamist saate aru, et vajate veel ühte veergu lisateabe jaoks. Kas te peate alustama tabeliga otsast peale? Muidugi mitte!

Veeru lisamiseks tuleb kõigepealt märgistada veerg, mille ette Te soovite uue veeru saada. Veeru (või rea) märgistamiseks tehke parem hiireklõps vastava veeru (või rea) tähisel, avaneb kiirmenüü:

[image: ]

Insert käsk lisab uue rea või veeru selekteeritu ette.  
Veeru või rea kustutamiseks valige samast menüüst Delete

[bookmark: RemoveDuplicateRows][bookmark: _Toc111618216][bookmark: _Toc113082871][bookmark: _Toc153614713][bookmark: _Toc168371382][bookmark: _Toc178582915][bookmark: _Toc256683227]Andmete kopeerimine ja teisaldamine

Lahtrite sisu kopeerimiseks , ühe töölehe või mitme avatud dokumendi piires on kaks võimalust:

1. Copy ja Paste käskudega:

a) Tee aktiivseks kopeeritav lahter (või lahtrite plokk)
b) Tee hiire parema nupu klõps ja vali hüpikmenüü käsk Copy (kopeeritav lahter on
ümbritsetud raami  ja "jooksva" punktiiriga)

[image: ]

c) Vali hiirega uus koht 
d)  Tee parema nupu klõps uues kohas ja anna käsk Paste. Võid Paste käsku korrata mõnes teises kohas.

[image: ]

NB! Kopeerimise/kleepimise lõpetab Enter vajutus.

2. Kopeerimine hiirega lohistades
· Märgi plokk, mida tahad kopeerida või teise kohta viia.
· Haara hiirega ploki piirjoonest kinni. Piirjoone tunnuseks on hiire kursori muutumine noolekujuliseks.
· Lohista plokk uude kohta. Kopeerimisel hoia all Ctrl klahvi, ümberpaigutamiseks pole seda vaja. Ctrl klahvi võib lahti lasta alles peale hiirenupu vabastamist. 
[image: ]
Lahtrite sisu teisaldamiseks 
ühe töölehe või mitme avatud dokumendi piires:
a) Tee aktiivseks ümberpaigutatav lahter (või vahemik), 
vajuta Cut nuppu [image: ]  või hiire parema klahvi alt Cut

 [image: ]

b) Tee aktiivseks lahter, kuhu soovid koopia paigutada ja vajuta klahvi Enter (või hiire parema klahvi alt Paste)

[bookmark: _Toc168371383][bookmark: _Toc178582916][bookmark: _Toc256683228]
Tabeli äärejooned

Exceli töölehel näed ruudujooni. Kui sa prindid oma tabeli välja, siis neid jooni ei prindita. Klõpsates Prindi eelvaate nuppu [image: ] näed samuti, et neid ruudujooni lehel ei ole
[image: ]
Kui soovid, et tabelil oleksid ka äärejooned, märgista tabel ja vali Borders (äärised)-nupu loendist  sobiv joonte paigutus

[image: ][image: ]



[bookmark: _Toc256683229][bookmark: _Toc168371385][bookmark: _Toc178582918]Numbrite vormindamine 
Vaikimisi rakendab Excel töölehe lahtrisse sisestatud arvulistele väärtustele General arvu vormindamise, - näitab arve täpselt sellisena, nagu need on sisestatud.  General vorming kehtib alati, kui lahtrile ei ole määratud mingit teist vormingut. 
Arvu vormindamine muudab ainult arvu välist kuju. Kuigi vormindus võib eemaldada näidatava arvu kümnendkohad, ei ümarda see arvu.
Excel pakub arvude kuvamiseks üsna mitmeid eri vorminguid. Vormingud võib lahtrile määrata kas enne andmete sisestamist või pärast:
[image: ]


Tabelis on toodud peamised vormingud arvude jaoks:
	Nimetus
	Tähendus
	Näide

	General
	Üldine. Kehtib, kui lahtrile pole määratud mingit teist vormingut.
Väärtus kuvatakse sellisel kujul nagu ta sisestatakse
	365,2457

	Number
	Püsikoma. Võimaldab määrata murdosa jaoks kindla pikkuse
	365,2457
365, 25
365,2

	Currency
	Raha. Arvu järele või ette lisatakse rahaühik, võimaldab kuvada komakohti
	200,00 kr
€250

	Date
	Kuupäev: Võimaldab vormindada kuupäevi erineval kujul
	01.09.08
1.september 2008.a.

	Time
	Kellaaeg
	12:25:31

	Percentage
	Protsent. Väärtus kuvatakse korrutatuna 100-ga, lõppu lisatakse %. Säilitatav väärtus ei muutu
	18%

	Scientific
	Ujukoma ehk eksponent. Arv esitatakse kümnendastmete kaudu.
3*107
	3E+07

	Text
	Tekst. Kuvamisel käsitletakse arvu tekstina, kui vorming on määratud enne sisestamist, siis säilitatakse kõik märgid
	12,234
+18
007

	Custom
	Kasutaja vorming. Luuakse olemasoleva vormingu alusel. Võimaldab luua oma enda arvu formaadi
	12 cm



Arvude vormindamiseks rohkem võimalusi pakub Format Cell dialoogiaken [image: Nupu pilt]  (või Ctrl+1)

[image: ]

 (
Fill
) (
Kuidas käituda negatiivsete numbritega
) (
Kohti pärast koma
) (
Kasuta tuhandete eraldajat
) (
Näed millisena number tuleks
) [image: ]

Currency ehk Valuuta realt 
saad lisaks komakohtadele ja negatiivse numbri värvile näidata ka kasutatava raha tähise. Pane tähele, et võimalik on valida ka raha rahvusvaheline tähis: 




Date ehk Kuupäev real on erinevad kuupäeva vormingud:
[image: ]
Kuupäevadega on tegelikult programmis nii, et ajaarvestus algab kuupäevast 1. jaanuar 1900. See on programmile kõige esimene päev. 2. jaanuar 1900 on päev nr. 2 jne.;   25. märts 2006 on järjekorras kuupäev nr. 38801
Kuupäevi saad klaviatuurilt päris kahel-kolmel meetodil:
1. Kasutad punkti või 
2. Kasutad kaldkriipsu (nn. jagamismärki). 

3.Tänase kuupäeva saad aga klahvikombinatsiooniga Ctrl+Shift+semikoolon



Kellaajad 
Kella pead kirjutama kooloniga:

Praeguse kellaaja saad klahvikombinatsiooniga Ctrl+Shift+Koolon
Time ehk Kellaaeg real on erinevad kuupäeva vormingud:
[image: ]


Format Cells  aknas on järgmised vahekaardid: 
[image: ]
· Number - numbriformaadi määramine
· Alignment - märgistatud lahtrite joondamise valimine
· Font - märgistatud lahtrites oleva teksti kirja kujundamine
· Border - saab lisada ja eemaldada lahtreid ümbritsevaid erikujulisi äärejooni
· Fill- märgistatud lahtritele värvi määramine
· Protection - saab ära määrata, kas märgistatud lahtrite sisu saab muuta ja kas näeb nendes lahtrites olevaid valemeid, kui tööleht on muutmiseks lukustatud käsuga Protect Sheet


[bookmark: _Toc153614715][bookmark: _Toc111618221][bookmark: _Toc113082876][bookmark: _Toc153614716][bookmark: _Toc168371386][bookmark: _Toc178582919][bookmark: _Toc256683230][bookmark: _Toc111618219][bookmark: _Toc113082873]
 Aritmeetika valemid

Excelile annavadki tegelikult mõtte valemid, mille abil tehakse andmetega arvutused ja kuvatakse kohe ka arvutuste tulemused. Ilma valemiteta tabeleid saab koostada ka tavaliste tekstitöötlusvahenditega.

Vaatame valemi koostamist:

[image: ]

· Valemi kirjutamist alustame alati võrdusmärgiga!
· Valemis võib kasutada konstante ja viiteid lahtritele.
· Lahtriviiteid võib valemisse kas kirjutada või märkida hiireklõpsuga viidataval lahtril

Valemites kasutatavad tehtemärgid ja sulgude kasutamine on sama kui tavalises aritmeetikas. Mõned tehtemärgid on erinevad sellest, mida oleme näinud kalkulaatoril. Kasutatakse ainult tavalisi sulge, ka mitu taset üksteise sees. Kandilisi ega loogelisi sulge ei kasutata.

Tehete järjekord valemites:

	Tehte nimetus
	Tehtemärk
	Tehte järjekord
	

	Astendamine
	^
	1
	AltGr+ää

	Korrutamine
	*
	2
	

	Jagamine
	/
	2
	

	Liitmine
	+
	3
	

	Lahutamine
	-
	3
	



[image: ]
Näide valemi sisestamisest:
[bookmark: _Toc168371387][bookmark: _Toc178582920][bookmark: _Toc256683231][image: ] 

Valemi kopeerimine

Üldjuhul on nii, et on vaja saada ühte valemit korraga mitmesse pesasse (näit. sama tulba 50nesse pesesse). Üsna tüütu oleks ühte valemit 50 korda sisse tippida. Palju lihtsam on valemit kopeerida.

1. Vali see pesa, mille sisu kopeerida tahad (samm 1). Jälgi, et valem oleks õigesti kirja pandud

2. Mine hiirega valitud pesa alumisse paremasse nurka (märgutud  ringiga). Hiirekursor muutub mustaks ristiks. Nüüd hoia all hiire vasakut klahvi ja sikuta kursorit alla niipalju kui vaja (samm 2).

3. Lase hiire klahv lahti. Valitud pesadesse peaks tekkima numbrid (samm 3).
Kui valem ole õige, siis on lootust, et ka tekkinud numbrid on sellised nagu vaja. Kui tekivad mingi veateated, vaata üle oma valem – ilmselt on selles mingi viga (näiteks otsitakse mingit väärtust tühjast pesast vms.)
[bookmark: _Toc153614717][image: ]
NB! Siin on lisanipiks kopeerimine allapoole – topeltklõps alumise parema nurga ruudul kopeerib valemi (nagu ka andmeseeria) tabeli lõpuni. Excel saab ise aru, kus tabel lõpeb.
 MÄRKUS.    Täitepidet saab valemite kopeerimiseks lohistada ainult lahtritesse, mis asuvad üksteise kõrval, kas siis horisontaalselt või vertikaalselt.
[bookmark: _Toc168371388][bookmark: _Toc178582921][bookmark: _Toc113082877][bookmark: _Toc153614718]

[bookmark: _Toc256683232]
Suhteline ja absoluutne aadress 

[image: Suht- ja absoluutviited]
[image: Viiktekst 1] Suhtviited muutuvad, kui neid kopeerida.
[image: Viiktekst 2] Absoluutviited ei muutu, kui neid kopeerida



Suhteline aadress kopeerimisel muutub. Enamasti valemit kopeeritakse kas piki veergu (alla) või piki rida (kõrvale). 
• Piki veergu kopeerimisel muutub reanumber. 
• Piki rida kopeerimisel muutub veerutähis. 

[bookmark: _Toc153614726][image: ]


Absoluutne aadress kopeerimisel ei muutu ja jätkab viitamist samale lahtrile, millele ta viitas lähtekohas. Absoluutsel aadressil on nii veeru tähise kui rea numbri ees dollarimärk $. 

[bookmark: _Toc153614727][image: ]



Koordinaatide (lahtriviidete) kopeerimisel muutumise vältimiseks tuleb vastava koordinaadi ette kirjutada $ märk. Seda eraldi nii rea- kui veerutähise juures. $ märk takistab ainult selle koordinaadi muutumist, mille ette ta on trükitud. See omakorda lubab koostada kombineeritud viiteid, mis käituvad erinevalt valemi kopeerimisel horisontaal- ja vertikaalsuunal.

Dollarimärkide sisestamiseks on Excelis klahv <F4>, mis valemi sisestamisel või korrigeerimisel lisab või eemaldab dollarimärke. 

[bookmark: _Toc168371389][bookmark: _Toc178582922][bookmark: _Toc219186804][bookmark: _Toc256683233]
Exceli Diagrammid 

[bookmark: _Toc111618233][bookmark: _Toc113082884][bookmark: _Toc153614719]Diagramm võimaldab mõtet paremini ja kiiremini esile tuua. Excel 2007 abil on võimalik luua diagrammi kümne sekundiga.  Pärast diagrammi loomist saate sellele hõlpsasti uusi elemente lisada. Näiteks võite lisada tiitli, et diagramm sisaldaks pisut rohkem teavet, või muuta diagrammielementide paigutust. Diagrammi abil saab töölehe andmeid kujutada võrdluste, mudelite ja trendidena.

Tulpdiagrammid sobivad mingi perioodi jooksul andmetes toimunud muutuste näitamiseks või üksuste võrdluse illustreerimiseks.

[image: Ruumiline kobartulpdiagramm]

Sektordiagrammidel kuvatakse ühe andmesarja (andmesari: Seostuvad andmepunktid, mis on kantud diagrammile. Igal diagrammi andmesarjal on ainuvärv või -muster, mida kirjeldatakse diagrammi legendis. Diagrammile saab kanda ühe või mitu andmesarja. Sektordiagrammis saab olla ainult üks andmesari.) elementide maht kõigi elementide kogusumma suhtes. Sektordiagrammil kuvatakse andmepunktid (andmepunktid: Diagrammile kantud iseseisvad väärtused, mida esitatakse andmemarkerite (nt ribade, tulpade, joonte, sektor- või rõngasdiagrammi lõikude, punktide või muude kujundite) abil. Samavärvilised andmemarkerid moodustavad andmesarja.) protsendina tervikust

[image: Ruumiline sektordiagramm]

Joondiagrammidel kuvatakse ajaliselt järjestikused andmed ühisel skaalal, seega sobivad need hästi andmete trendi näitamiseks võrdsete ajavahemike tagant.

[image: Tähistega joondiagramm]
[bookmark: _Toc256683234]Diagrammi loomine

1) Diagrammi tegemiseks koosta kõigepealt tabel algandmetega!
2)  Märgi plokk diagrammi algandmetega, koos veerunimetuste ja reanimedega, kuid kindlasti ilma summarea või summaveeruta

[image: ]

NB! Mitu andmeplokki saab märgistada Ctrl klahvi all hoides!

3) Seejärel klõpsake menüü Insert jaotise Charts nuppu Column (Tulpdiagramm). Võite valida ka mõne muu diagrammitüübi, kuid tavaliselt kasutatakse andmete võrdluseks ja esitamiseks tulpdiagramme.

4)  Pärast nupu Column klõpsamist kuvatakse valik tulpdiagrammi tüüpe. Kursorit mõne diagrammitüübi peal hoides kuvatakse kohtspikris selle diagrammitüübi nimi. Lisaks kuvatakse kohtspikris ka diagrammitüübi kirjeldus ning soovitus, kus seda tüüpi diagrammi kasutada.


Ongi kõik, diagrammi loomiseks kulus umbes kümme sekundit! 



[bookmark: _Toc256683235]
Diagrammi kujundamine
Diagrammi luues kuvatakse lindil menüü Chart Tools (Diagrammiriistad), mis sisaldab alammenüüsid Design (Kujundus), Layout  (Paigutus) ja Format (Vorming). Nendes menüüdes asuvad diagrammiga töötamiseks vajalikud käsud. Saate siit vormindada diagrammi elemente, näiteks diagrammiala (diagrammiala: terve diagramm koos kõigi oma elementidega.), andmeala (graafikuala: tasapinnalisel diagrammil telgedega ääristatud ala (sh kõik andmesarjad). Ruumilisel diagrammil telgedega ääristatud ala (sh kõik andmesarjad, kategoorianimed, märgistussildid ja teljetiitlid).), andmesarju (andmesari: seostuvad andmepunktid, mis on kantud diagrammile. Igal diagrammi andmesarjal on ainuvärv või -muster, mida kirjeldatakse diagrammi legendis. Diagrammile saab kanda ühe või mitu andmesarja. Sektordiagrammis saab olla ainult üks andmesari.), telgi (telg: diagrammi graafikualaga külgnev joon, mida kasutatakse taustmõõdustiku määratlemiseks. Y-telg on enamasti vertikaalne ja sisaldab andmeid. X-telg on enamasti horisontaalne ja sisaldab kategooriaid.), tiitleid (tiitlid diagrammides: kirjeldav tekst, mis joondatakse automaatselt teljega või diagrammi ülaosa keskele.), andmesilte (andmesilt: silt, mis annab lisateavet ühte andmepunkti või töölehe lahtrist pärinevat väärtust tähistava andmemarkeri kohta.), legende (legend: boks, mis seletab diagrammis andmesarjadele või kategooriatele määratud mustrite ja värvide tähendust.) jm.

[image: ]
[bookmark: _Toc256683236]
Vahekaart <Design> - diagrammi ilme

Pärast diagrammi loomist saate seda professionaalsema ilme andmiseks kohandada. Diagrammi ilme muutmiseks võite valida uue diagrammilaadi, mis muudab kiiresti diagrammi värve

[image: ]


 


[bookmark: _Toc256683237]Diagrammitüübi muutmine

Kui soovite diagrammitüüpi muuta pärast diagrammi loomist, klõpsake selle sees. Seejärel klõpsake menüü Chart Tools (Diagrammiriistad) nuppu Change Chart Type (Muuda diagrammi tüüpi) ning valige mõni muu diagrammitüüp.
 (
Diagrammitüübi 
muutmine
)

[image: ]

Switch Row/Column nupu abil saab valida kas Excel rühmitab andmed töölehe veergude kaupa või ridade kaupa
[bookmark: _Toc256683238]
Diagrammi asukoht

Saab ka määrata, kas diagramm tuleb objektina töölehele tabeli juurde (Object in) või luuakse töövihikusse uus leht ainult diagrammi jaoks (New sheet).

[bookmark: _Toc113082885]
 (
Diagrammi
asukoha valik
)[image: ]
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[bookmark: _Toc256683239]
Vahekaart <Format> diagrammi elementide vormindamine

Kui jaotises Chart Styles  ei ole teile sobivat laadi, võite otsustada muude värvivalikute kasuks, valides mõne muu kujunduse. Värvi lisamiseks klõpsake ühte tulpadest,  siis klõpsake menüü Format nuppu Shape Fill. Kursorit mõne värvi kohal hoides kuvatakse see värv diagrammil ajutise eelvaatena

[image: ]

Tulpade ümber kontuuri lisamiseks klõpsake nuppu Shape Outline (Kujundi kontuur). Nupu Shape Effects (Kujundiefektid) all on ka muid suvandeid peale varjude. Näiteks saate tulpadele lisada viltuse efekti või sujuvad servad või isegi sära.

[image: Menüüs Vorming asuvate kujundilaadide suvandite abil varjuefektide lisamine diagrammi tulpadele]

Kui diagramm on valmis, klõpsake väljaspool diagrammiala. Seejärel diagrammiriistad kaovad. Kui soovite neid uuesti näha, klõpsake diagrammi sees. Menüüd kuvatakse uuesti.
[bookmark: _Toc256683240]Vahekaart <Layout> - andmete lisamine diagrammile

[image: ]
 (
Diagrammi tiitel
) (
andmetabel
) (
Legend
)
 (
Telgede tiitlid
) (
andmesildid
)

[bookmark: _Toc219186812][bookmark: _Toc256683241]Diagrammitiitlite lisamine

Diagrammidele on mõttekas lisada kirjeldavad tiitlid, et lugejad ei peaks mõistatama, millega on tegu. Tiitli saab panna nii diagrammile endale kui ka telgedele, mis mõõdavad ja kirjeldavad diagrammi andmeid. Tulpdiagrammil on kaks telge. Vasakul asub vertikaaltelg (seda nimetatakse ka väärtus- ehk Y-teljeks). See telg on numbriskaala, mille abil on kergem tulpade kõrgusest aru saada. Diagrammi alaosas oleval horisontaalteljel (seda nimetatakse ka kategooria- ehk X-teljeks) asuvad kuud.




[bookmark: _Toc256683242]Diagrammi andmesiltide lisamine ja eemaldamine ehk Data Labels
[bookmark: AddDataLabels]
Sildi lisamiseks kõigile andmepunktidele klõpsake diagrammiala (diagrammiala: Terve diagramm koos kõigi oma elementidega.) (üksikule andmepunktile andmesildi lisamiseks klõpsake sildistatavat andmepunkti sisaldavat andmesarja). Seejärel kuvatakse menüü Chart Tools. Klõpsake menüü Layout käsku Data Lables (Andmesildid) ja seejärel soovitavat kuvamissuvandit .
NB! Saadaolevad andmesildisuvandid sõltuvad kasutatavast diagrammitüübist.

[image: ]
[image: ]

 (
lisasuvandid
)















Andmesiltide lisasuvandite kuvamiseks klõpsake käsku More Data Label Options ja käsku Label Options, kui seda pole juba valitud, ning seejärel valige soovitavad sildisuvandid.
[bookmark: _Toc256683243]
Diagrammi elementide vormindamine 
Diagrammielementide muutmiseks võib teha ka hiire parema klahviga klõps soovitud  elemendil ning avanenud kiirmenüüs valida <Format...>  Ekraanile ilmub aken, kus saab muuta elemendi määranguid.

[image: ]          [image: ]






[bookmark: _Toc256683244]Andmeseeriate sisestamine
Numeratsiooni, kuude nimetusi, nädalapäevi jne. ei pea ise trükkima. Piisab kui sisestate ühe esimese nime (näit. jaanuar) ja programm täidab järgnevad lahtrid loogilises järjestuses. 

Andmeseeriate kasutamiseks sisesta esimene nimetus lahtrisse ja lõpeta sisestamine Enter klahviga, seejärel vii hiire kursor lahtri parema alumise nurga juurde, et kursor muutuks musta värvi ristiks.

[image: ]Siis lohista hiire vasakut nuppu all hoides üle järgnevate lahtrite. Excel täidab ülejäänud lahtrid järgmiste nimetustega vastavalt valitud andmeseeriale.

[image: ][image: ][image: ]   	[image: ] [image: ][image: ]

Andmeseeriaid saab moodustada ka arvudest. Siis tuleb alguses trükkida kaks arvu, nad mõlemad märkida ja nurgast sikutada. Erandina järjestikuste kuupäevade seeria saamiseks piisab ühest kuupäevast. Andmeseeriaid võib luua kõigis neljas suunas.

Uue andmeseeria loomine
Uusi andmeseeriaid on võimalik ka ise lisada, selleks vali: Office nupp[image: Nupu pilt]-> Excel Options -> Edit Custom Lists
[image: ]
Kastis Custom List on näha olemasolevad andmeseeriad, uut lisamiseks sisesta nad List entries kasti üksteise alla või komaga eraldatult ja seejärel vajuta Add nuppu. Vasakpoolsesse aknasse tekib uus andmeseeria.

[bookmark: _Toc153614722][bookmark: _Toc168371392][bookmark: _Toc178582924] 


[bookmark: _Toc256683245]
Andmete sorteerimine

Andmete sorteerimine on andmeanalüüsi lahutamatu osa. Võite soovida järjestada nimesid tähestikuliselt, koostada tootenimekirju kõrgemast madalama tasemeni või järjestada ridu värvi järgi. Andmete sortimine aitab andmeid kiirelt visualiseerida ja paremini mõista.


Sorteerimine võimaldab tabeli kirjeid (ridu) kuvada soovitud järjestuses kas väärtuste kasvamise 
([image: ] Ascending) või kahanemise (Descending[image: ] ) järjekorras.



Sorteerimine

1) Selleks märkige  üks lahter selles veerus, mille järgi tahate sorteerida. 
2) Klõpsake menüü Home nuppu Sort &Filter 
[image: ]
Tähestikulises järjekorras sortimiseks klõpsake[image: ]  Sort A to  Z 

Laskuvas tähestikulises järjekorras sortimiseks klõpsake [image: ] Sort Z to A




[image: ]


[bookmark: _Toc113082874]Sorteerimine vahetab töölehel read ära.  Ümber paigutatakse kõik see, mis asub loetelu kõrval.  Kui sul on vaja säilitada võimalus taastada tabel esialgses järjestuses, siis selle võimaldamiseks võib esialgsele tabelile lisada veeru järjekorranumbritega.

Põhjalikum sorteerimisekorraldus on menüüs Custom Sort.  Antud korraldust kasutades saab kirjeid sorteerida lahtri või fondi värvi järgi. Võimalik on kasutada ka mitmel alusel sorteerimist. Sellisel juhul sorteeritakse andmeid teise aluse kriteeriumi järgi ainult sellisel juhul, kui esimese kriteeriumiga sorteerimisel saadakse korduvaid väärtusi (näiteks kui perekonnanimed on samad siis sorteeritakse eesnimede järgi)

Sortimine mitme tingimuse järgi
1) veenduge, et aktiivne lahter paikneb tabeli sees
2) valige Sort & Filter -> Custom Sort
[image: ]








Kuvatakse dialoogiaken Sortimine

[image: ]

3) Valige jaotise Column boksis „Sort by“ veerg, mille järgi soovite sortida (nt pikkus)
4) Valige jaotises Order (Järjestus) sortimisviis:
·  valige Väikseimast Suurimani (Smallest to Largest)
· või Suurimast Väikseimani (Largest to Smallest)
Veel ühe tingimuse lisamiseks klõpsake nuppu Add Level  ja korrake juhiseid 3-4. 

[image: ]



[bookmark: _Toc168371393][bookmark: _Toc178582925][bookmark: _Toc256683246]
Andemete filtreerimine


Filtreerimisel varjatakse filtreerimistingimustele mittevastavad kirjed (read) ja nähtavaks jäävad ainult tingimustele vastavad kirjed. Pärast andmete filtreerimist saate filtreeritud andmeid kopeerida, vormindada, lisada diagrammi ning printida ilma neid ümber korraldamata või teisaldamata.

Filtreerida saate ka mitme veeru alusel. Filtrid on täiendid. See tähendab, et iga lisatav filter põhineb praegusel filtril ning iga järgmine vähendab andmete alamhulka. 

AutoFilter lubab vaadelda andmebaasi ridu, mis vastavad etteantud tingimustele ja peita ülejäänud read. Korraldus Sort & Filter ->Filter, lisab igale veerupealkirjale noolega nupu. 

[image: ]














Hiireklõps vastaval noolel avab loetelu, millest tuleb valida väärtus, mida soovitakse kasutada filtreerimistingimusena.


[image: ]

Märkige või tühjendage tekstväärtuste loendis filtreerimisel kasutatavad väärtused.  Kui loend on pikk, tühjendage üleval ruut (Select All) ning valige filtreerimiseks kindlad tekstväärtused.
Peale andmekogu filtreerimist ilmub Excel olekuribale (status bar) ekraani allääres teade selle kohta, mitu rida valitud kriteeriumile vastas:

[image: ]

Lisaks sellele muudab rippnool kuju (filtri sümboliks [image: Rakendatud filtri ikoon]), mis näitab, et list on filtreeritud selle veeru järgi. Samuti reanumbrid muudavad värvi, mis on filtreerimise tunnuseks. 

Kui filtreerida mitme veeru järgi, siis jäävad nähtavale ainult need read, mis vastavad kõigile määratud tingimustele.
Filtri tühistamiseks klõpsake päises filtrinuppu [image: Rakendatud filtri ikoon]ja seejärel klõpsake käsku Clear Filter
[bookmark: _Toc178582926][bookmark: _Toc168371394][bookmark: _Toc256683247]

Kohandatud filter ehk Custom Filter

Filtri loetelus on olemas valik Custom Filter, mis laseb kasutajal sisestada keerukamat tingimust. 

[image: ]



[image: ]

And – mõlemad tingimused peavad olema täidetud
Or- üks tingimustes peab olema täidetud


Näiteiks, siin ma eraldan need read, kus doonori vanus on suurem kui 40
 (
40
) (
„suurem kui“
)[image: ]

Siinses näites filtreerib programm kahe tingimuse alusel: neid, kelle vanus on suurem kui 20 ja samal ajal ka väiksem kui 30. Seega antud juhul otsib programm vahemikku:
[image: ]


Võimalikud tingimused:
[image: exceliyl229]

[bookmark: _Toc168371395][bookmark: _Toc178582927][bookmark: _Toc219186817]
Teksti sisaldavate lahtrite otsimine

Eelkõige valige lahtrite vahemik, millest soovite otsida. Kui soovite otsida kogu töölehelt, siis klõpsake suvalist lahtrit.  Klõpsake käsku Find (ehk Ctrl+F) 

[image: ]

Sisestage väljale Find what tekst või arvud, mida soovite otsida. Klõpsake nuppu Find All (Otsi kõik) või Find Next (Otsi järgmine). 


[bookmark: _Toc183941626][bookmark: _Toc243379195][bookmark: _Toc168371399][bookmark: _Toc178582928][bookmark: _Toc256683248]

Ridade/veergude külmutamine ekraanile
View->Freeze Panes

Kujutage ette, et te kerite Exceli töölehte allapoole. Kerimise ajal kaovad aga veerupealkirjad ekraanilt. See võib tekitada olukorra, kus te ei tea enam, kas arvud veerus tähendavad ühikuid laos või tellimisel olevaid ühikud.

Külmutamine
Paanide külmutamiseks klõpsake menüü View käsku Freeze Panes (Külmuta paanid).

[image: ]



NB! Ridade ja veergude samaaegseks lukustamiseks valige lahter, millest ülespoole jäävad read ja vasakule jäävad veerud soovite lukustada.

Kui teil esimesel korral midagi valesti läheb, saate lihtsa vaevaga paanid jälle vabastada ning uuesti proovida. Selleks klõpsake käsku Unfreeze Panes.





[bookmark: _Toc256683249]
Töötamine funktsioonidega

Lisaks valemitele saame kasutada Excelis ka funktsioone. Funktsioonid on eelnevalt määratletud valemid, nende valik on oluliselt suurem, kattes palju tegevusvaldkondi. Funktsioonide abil saate kiiresti ja lihtsalt luua valemeid, mida võib olla keeruline ise koostada.

[bookmark: _Toc113082879][bookmark: _Toc153614723][bookmark: _Toc168371400]MS Excelil on üle 300 funktsiooni, mis teevad töö väga tõhusaks ning säästavad teie aega. 

Funktsioonil on kaks põhilist osa:

· Funktsiooni nimi - määrab, mida funktsioon teeb
· Argument  - määrab, milliseid väärtusi või lahtrite viiteid funktsioon arvutustes peab kasutama. Argumendid peavad olema alati sulgudes.


Näiteks:  

 =SUM(A1:A3)

„=“   (kõik valemid ja funktsioonid algavad võrdusmärgiga)
„SUM“   – funktsiooni nimi (summeerimine)
„(A1:A3)“ – argument (arvusid sisaldavate lahtrite piirkond)



Funktsiooni nimi ei ole tõusutundlik, st „Sum“ ja „sum“ on sama mis „SUM“. Excel muudab kõikide funktsioonide nimedes olevad tähed suurtähtedeks.


[bookmark: _Toc178582929]

[bookmark: _Toc256683250]
Funktsioonitarga (Insert Function) kasutamine

Kõige lihtsam moodus funktsioonide sisestamiseks on kasutada funktsioonitarga nuppu [image: Valemiriba] 
(Insert Function). Funktsioonitark kontrollib, et funktsioon oleks õigesti sisestatud.
[image: ]
 (
funktsiooni liik ehk kategooria
)[image: ]


[bookmark: _Toc256683251]Keskmise leidmine (AVERAGE funktsioon)

1. Märgista lahter, kuhu keskmine tuleb

2. Vajuta nupule valemitark [image: ]

3. Vali funktsiooni liigiks Statistical ning leia funktsioon AVERAGE

 (
AVERAGE - keskimine
) (
Statistical
 
kategooria
)[image: ]

4. Märgista hiirega vajalikud lähteandmed
[image: ]

5. Andmeplokile, mille keskmist leitakse, ilmub ümber punktiirjoon. Kontrolli, kas punktiirjoon on ümber õigete andmete, vajadusel lohista hiirega üle õigete andmete.
6. Vajuta OK. Lahtrisse ilmub keskmine!

Valemitarga kasutamine on tegelikult samaväärne valemi kirjutamisega otse lahtrisse või valemireale. Kui kasutatav funktsioon on sulle tuttav, võid funktsiooni ja selle argumendid lahtrisse ise käsitsi  sisse trükkida. Sageli on see kõige tõhusam meetod!


NB! Keskmise või Summa leidmiseks võid kasutada ka Automaatsumma loendi valikunoolt:

 (
keskmine
)
[image: ]



[bookmark: _Toc168371401][bookmark: _Toc178582930][bookmark: _Toc256683252][bookmark: _Toc111618220]Tingimusfunktsioon (IF funktsioon)

Vahel on otstarbekas tabelitöödes kasutada tingimusfunktsiooni, millel on üldkuju
=IF(tingimus;  toiming, kui tingimus on tõene;  toiming, kui tingimus on väär).
IF funktsioon tagastab ühe väärtuse, kui etteantud tingimus on täidetud ja teise väärtuse kui etteantud tingimus ei ole täidetud.
[image: ]
Näiteks: Kõigile veerus PÄEVI leiduvatele 10 suurematele arvudele kirjuta juurde tekst "üle 10 päeva",   ülejäänutele  "-"

[image: ]



1. Aseta kursor lahtrisse E4
2. Vajuta nupule valemitark: [image: ]

3. Vali funktsiooni liigiks Logical ning leia funktsioon IF
 (
funktsioon
 IF
) (
Logical
 kategooria
)[image: ]
[image: ]
Valem:     =IF(D4>10;"üle 10 päeva";"-")
[bookmark: _Toc156895493][bookmark: _Toc162769343]Pärast valemi sisestamist ilmub lahtrisse E4 kiri „Üle 10 päeva“
[bookmark: _Toc168371396][bookmark: _Toc178582932]Kopeeri valem ka tabeli ülejäänud lahtritele!
[image: ]
[bookmark: _Toc168371397][bookmark: _Toc178582933][bookmark: _Toc111618222][bookmark: _Toc113082878]
[bookmark: _Toc256683253] (
Kasutades IF funktsiooni tee nii, et kui 
patsiendil  
t
⁰
 on kuni 37,0 kraadini,  siis paneks programm C tulpa 
sõna „
normis
"
,
 kui aga on t
⁰
 
on 
37,0 või üle, siis paneb sõna "
palavik
".
)
veel üks näide:

	NIMI
	tO
	diagnoos

	Riina
	36,6
	???

	Paul
	36,7
	???

	Tiiu
	38,3
	???

	Kalle
	36,6
	???

	Malle
	36,6
	???

	Pille
	36,8
	???

	Tiina
	36,6
	???

	Raul
	37,0
	???

	Anne
	38,2
	???

	Olga
	36,4
	???

	Vahur
	39,5
	???

	Mari
	36,6
	???

	Eve
	36,6
	???




lahendus:

[image: ]

Kommentaaride lisamine

Microsoft Office Excelis saate kommentaari sisestamisega lahtrile märkuse lisada. Kommentaaride tekste saab redigeerida ning ebavajalikke kommentaare kustutada.

Kommentaari lisamiseks

1 Paremklõpsake lahtrit, kuhu soovite kommentaari lisada. 
2 Valige Insert -> Comment

[image: ]3 Tippige kommentaari tekst kommentaari tekstiväljale.
4 Kui olete teksti tippimise lõpetanud, klõpsake väljaspool kommentaarikasti.

[bookmark: RemoveComment]Väike punane kolmnurk lahtri nurgas näitab, et lahtrile on lisatud kommentaar. Kommentaar kuvatakse, kui hoiate kursorit punase kolmnurga peal. Kommentaari kustutamiseks tehke hiirega paremklõps lahtril ja valige Delete Comment.
[bookmark: _Toc111618229][bookmark: _Toc113082882][bookmark: _Toc256683254]
Dokumendi salvestamine

Vaatame nüüd kuidas salvestada oma suure hoolega tehtud tööd arvutisse. Vastasel juhul, kui sa sulged nüüd programmi, kaob ka sinu töö. Töid, mis on arvutis salvestatud, nimetatakse failideks.

Klõpsake Microsoft Office'i nuppu[image: Nupu pilt] ja seejärel käsku Save As. 
Klaviatuuri otsetee  Faili salvestamiseks vajutage klahvikombinatsiooni CTRL+S.


Seejärel avaneb aken nimega Save As:


 (
Salvestamine
) (
Failinimi
) (
Salvestuskoht
)[image: ]

Kõigepealt tuleb oma tööle nimi anda. Selleks vaatame salvestusakna alumist äärt, kus on kirjas File name. Tee selles lahtris vasaku hiireklahviga üks klõps ja hakka klaviatuurilt tähti sisestama. Failinimi võib olla pikk kuni 255 sümbolit. Nimes võib kasutada nii suuri kui ka väikesi tähti kui ka tühikuid.

Samuti tuleb valida kettaseadet, kuhu fail salvestada (Save in)

Salvestamise kinnitamiseks klõpsa nupul Save


[bookmark: _Toc178582936][bookmark: _Toc256683255]
Töölehe ettevalmistus väljatrükiks ja väljatrükk

Enne printimist peab kontrollima, milline näeb tabel välja lehele prindituna. Selline võimalus lehekülje vaatlemiseks on menüüs Print Preview [image: ]

[image: ]

Prindi eelvaatluses muutub nupuriba:

[image: ]


	Nupp
	Selgitus

	Print
	Printimine

	Page Setup
	Lehekülje häälestus

	Zoom
	Suurendus

	Next page
	Järgmine leht

	Previous page
	Eelmine leht

	Show Margins
	Äärised

	Close Print
	Prindi eelvaate sulgemine




[bookmark: _Toc178582937][bookmark: _Toc207787410][bookmark: _Toc219186826][bookmark: _Toc256683256]Lehekülje häälestus

Tuleb kontrollida ka lehe suurust, ääriseid, lehekülje päiseid ja
jaluseid. Selleks valige Page Setup

 (
1 lehele automaatne sobitamine
) (
suum ehk 
mastaab
)[image: ]

Orientation – lehe orientatsioon
Scaling – tabeli suurunduse või vähenduse muutmine normaalsest %
Fit to – lehele sobitamine



Vahekaart Margins võimaldab määrata lehe äärised ja tsentreerida nii horisontaalselt kui ka vertikaalselt:

 (
h
ori
s
ontaalne tsentreerimine
)[image: ]

Vahekaardil Header/Footer saab kujundada lehekülje päised ja jalused. Selleks tuleb nupust Edit avada vastav dialoogiaken ning teha seal vajalikud muudatused


[bookmark: _Toc178582938][bookmark: _Toc207787411][bookmark: _Toc219186827][bookmark: _Toc256683257]

Töölehe väljatrükk 
Väljatrükkimiseks klõpsake Office nuppule [image: Nupu pilt] -> Print -> Quick Print [image: ] (prindib kogu töölehe).

Kui on soov printida valikuliselt, avage menüüst Office-> Print-> Print   või <CTRL+P> ja
seejärel avaneb printimise dialoogiaken.
[image: ]


[image: ]

[bookmark: _Toc209850448]
[bookmark: _Toc256683258]Enamkasutatavad Microsoft Exceli kiirklahvid



CTRL+A	select all – terve tabeli (või töölehe) selekteerimine
CTRL+C	kopeerimine
CTRL +V (või ) Enter	kleebimine
CTRL+N  	loob uue tühja töövihiku
CTRL+Z 	Kasutab käsku Undo (Võta tagasi )
CTRL+P 	kuvab dialoogiboksi Printimine
CTRL+F2 	kuvab akna Prindi eelvaade
CTRL+F  	kuvab dialoogiboksi Find (Otsing)
CTRL+1	kuvab dialoogiakna Format Cells 
CTRL+5 	rakendab või eemaldab läbikriipsutuse
F4 	abosluutne aadress valemis (ei muutu kopeerimisel)
F12 	Kuvab dialoogiboksi „Nimega salvestamine“ Save As
SHIFT+F2 	lisab või redigeerib lahtri kommentaari
SHIFT+F3	 kuvab dialoogiboksi Funktsiooni lisamine
ALT+4	filtri rakendamine
ALT+F1 	loob praeguses vahemikus olevate andmete diagrammi
CTRL+SHIFT+; 	sisestab tänase kuupäeva
CTRL+SHIFT+: 	sisestab praeguse kellaaja
CTRL+SHIFT+& 	rakendab valitud lahtritele välisäärise 
CTRL+SHIFT+ - 	eemaldab valitud lahtritelt välisäärise
CTRL+SHIFT+~ 	rakendab üldise arvuvormingu
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